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R-IN32M3 シリーズ 
PROFINET 通信手順 スタートアップマニュアル 

要旨 
本マニュアルでは、ルネサスエレクトロニクス製 R-IN32M3-EC 評価ボードを用いて、CODESYS Software 

PLC と接続して、PROFINET 通信を行うまでの手順について説明します。 

本パッケージの R-IN32M3 PROFINET スタックサンプルプログラム(以下、サンプルプログラム)は Arm® 
Cortex®-M3 コアで動作します。R-IN32M3 シリーズ製品による PROFINET 機器の開発を始める方を対象に構

成しています。 

各機能の詳細については、別途、ルネサスエレクトロニクスのホームページからドキュメント類をダウン

ロード頂けます。 

 

動作確認デバイス 
R-IN32M3 シリーズ 

 

本サンプルプログラム 
本サンプルプログラムは、弊社パートナーの株式会社シェルパ製 PROFINET スタックの評価版を使用し

ています。 

正式版のご購入に関しては、株式会社シェルパにお問い合わせください。 

 

株式会社シェルパ：https://www.sherpa-tech.net/ 
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1. 動作環境 
 

本マニュアルのサンプルプログラムは、下記の環境を想定しています。 

 

表 1.1 動作環境 
項目 内容 

使用ボード R-IN32M3-EC 評価ボード 
 TS-R-IN32M3-EC 

MCU R-IN32M3 
動作周波数 100MHz 
動作電圧 3.3V 
動作モード ・命令 RAM ブート 

・外部シリアル FlashROM ブート 
使用デバイス シリアルフラッシュメモリ 

Spansion 製 S25FL032P0XNFI010 
通信プロトコル PROFINET 
統合開発環境 IAR システムズ 製 

Embedded WorkbenchⓇ for Arm Version 7.80 
エミュレータ IAR システムズ 製 

I-jet 
ソフトウェア PLC 3S-Systems GmbH 製 

CODESYS V3.5 SP11 
 

※本マニュアルでは、統合開発環境、ソフトウェア PLC のインストールは完了しているものとしていま

す。 

ソフトウェア PLC は、リンクス社のサイト(http://linx.jp/download/codesysv3)より入手ください。 
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2. R-IN32M3-EC 評価ボードの設定と接続 
ボードの詳細情報に関しては、「ユーザーズマニュアル」をご参照ください。 

http://www.tessera.co.jp/ts-r-in32m3.html 

 

2.1 R-IN32M3-EC 評価ボードの設定 
電源投入前に、DIP-SW とジャンパの設定を行い、各ケーブルを接続します。関連する部品の位置を下図に

示します。 

 

図 2.1 設定箇所およびケーブル接続位置 

 

 

  

R-IN32M3-EC 評価ボード 
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2.2 R-IN32M3-EC ボードの起動設定 

R-IN32M3 は，外部端子（BOOT0,BOOT1）で起動するターゲットを選択します。R-IN32M3-EC 評価ボー

ドのブート・モードの選択は，MODE_SW（SW1）で設定します。 

ブート・モード選択は，5V-3A の DC アダプターを接続する前に設定して下さい。 

 

表 2.1 動作モード選択 

MODE_SW（SW1） 
ブート・モード選択設定 

1 2 

ON(High) ON(High) 命令 RAM ブート（デバッグのみ使用可能） 

OFF(Low） ON(High） 外部マイコン・ブート 

ON(High) OFF(Low) 外部シリアル FlashROM ブート 

OFF(Low) OFF(Low) 外部パラレル FlashROM ブート 
 

 

 

2.3 R-IN32M3-EC 評価ボードの接続 
以下のように、各ケーブルを接続してください。 

(1) Ethernet ケーブル(カテゴリ 5 推奨)を CN16 に接続。 

(2) ICE (I-jet) の JTAG コネクタを CN1(ARM JTAG20)に接続し、ホストコンピュータと USB 接続。 

(3) DC5V 出力 AC アダプターを CN15 に接続し、電源を投入。 

 

 

 

  

R-IN32M3-EC 評価ボード 

 

CN16 

■命令 RAM ブート設定(MODE_SW(SW1[1:8])) 

  
MODE_SW 

R-IN32M3 
■外部シリアル FlashROM ブート設定
(MODE_SW(SW1[1:8])) 

TS-R-IN32M3-EC 

ON  ■■□□□□□□ 

OFF □□■■■■■■ 

TS-R-IN32M3-EC 

ON  ■□□□□□□□ 

OFF □■■■■■■■ 
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3. R-IN32M3 PROFINET スタックサンプルプログラムの起動 
 

3.1 プロジェクトの起動とビルド 
 

(1) Windows のスタートメニューから、[すべてのプログラム] → [IAR Systems] → [IAR Embedded 
Workbench for Arm x.xx] → [IAR Embedded Workbench] をクリックし、IAR Embedded Workbench を起動し

ます。 
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(2) [File] → [Open] → [Workspace] で 

¥an-r01an4282jj0100_rin32m3_profinet¥R-IN32M3_PROFINET_sample にある” rin32m3_profinet.eww”ファイ

ルをダブルクリックし、ワークスペースを開きます。 

 
 

 

(3) 下記の 2 種類(Debug, Release）からビルド設定を選択して下さい。 

【ICEからR-IN32M3内部RAM（iRAM）で実行する場合】 

「2.2 R-IN32M3-ECボードの起動設定」で命令RAMブートを選択した場合は，”Debug”を選択して下さい。 

 

【ICEからR-IN32M3外部シリアルFlashROMで起動する場合】 

「2.2 R-IN32M3-EC ボードの起動設定」で外部シリアル FlashROM ブートを選択した場合は，”Release”を選

択して下さい。 
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 (4) [Project] → [Rebuild All] でビルドを実行します。 

 

 
 
  



R-IN32M3 シリーズ PROFINET 通信手順 スタートアップマニュアル 

R01AN4282JJ0100  Rev.1.00  Page 9 of 34 
2018.3.23  

 

3.2 プログラムの起動 
 

[Project] → [Download and Debug] でプログラムをターゲットにダウンロードし、[Go]ボタンをクリックし

て、プログラムを起動します。 
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4. CODESYS との通信確認 
 

4.1 CODESYS の起動 
(1)Windows のスタートメニューからすべてのプログラム > 3S CODESYS > CODESYS > CODESYS Vx.x(x.x 

はバージョン)を選びます。またはインストール後にデスクトップに作成される CODESYS アイコンからも

起動できます。 

 

(2) [File]→[Open Project …]をクリックし、¥an-r01an4282jj0100_rin32m3_profinet¥にある” Renesas_R-
IN32M3_PROFINET.project”ファイルをダブルクリックし、プロジェクトを開きます。 

 

CODESYS の新規プロジェクト構築についての手順及び UI 作成・確認手順については、「R-IN, RZ/T1, 
EC-1, TPS-1 グループ Software PLC Guide プロジェクト構築・UI 作成編」を参照してください。 
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(3) プロジェクトが起動されると、デバイスツリーが表示されます。 

 

 

 

4.2 スレーブデバイスの更新 
本章は、¥an-r01an4282jj0100_rin32m3_profinet¥ にある” Renesas_R-IN32M3_PROFINET.project”を初めて起動

する時のみ行います。 

 

4.2.1 デバイス情報のインストール 
PROFINET スレーブデバイスを使用するには、デバイス情報が記述されている GSD(General Station 
Description)ファイルのインストールが必要となります。 

GSD ファイルは、¥an-r01an4282jj0100_rin32m3_profinet¥R-IN32M3_PROFINET_sample¥ 
devicedescription¥profinet にある”GSDML-V2.34-SHERPA-RIN-ENGINE-CCB-20180614.xml”をご利用くださ

い。 

CODESYS 上の「ツール」メニューから「デバイスリポジトリ」を選択します。 
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デバイスリポジトリダイアログにて、「インストール」をクリック、ファイルダイアログが表示されますの 

で、¥an-r01an4282jj0100_rin32m3_profinet¥R-IN32M3_PROFINET_sample¥devicedescription¥profinet にある、

GSD ファイル「GSDML-V2.34-SHERPA-RIN-ENGINE-CCB-20180614.xml」を指定してください。インス

トール結果については下図の通り青枠内に表示されますのでご確認ください。正常に処理が行われた場合は

結果の横に とアイコンが表示されます。 
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4.2.2 デバイスの更新 
 

(1) デバイスの更新 

デバイスウィンドウの「Device(CODESYS Control Win V3)」上で右クリック、「Update Device …」を選択

します。 

 

 

デバイスの更新ダイアログにて、「PLCs－SoftMotion PLCs」以下にある「CODESYS Control Win V3」を選

択し「Update Device」ボタンをクリックします。 
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(2) Ethernet の更新 

デバイスウィンドウの「Ethernet(Ethernet)」上で右クリック、「Update Device …」を選択します。 

 

 

デバイスの更新ダイアログにて、「Fieldbusses – ProfinetIO - Ethernet Adapter」以下にある「Ethernet」を選 

択し「Update Device」ボタンをクリックします。 
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(3) PN_Controller の更新 

デバイスウィンドウの「PN_Controller (PN_Controller)」上で右クリック、「Update Device …」を選択しま

す。 
 

 
デバイスの更新ダイアログにて、「Fieldbusses – Profinet IO – Profinet IO Master」以下にある

「PN_Controller」を選択し「Update Device」ボタンをクリックします。 
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(4) SHERPA_PROFINET_IO_Reference_Device_for_R_IN32M3 の更新 

デバイスウィンドウの「SHERPA_PROFINET_IO_Reference_Device_for_R_IN32M3 
(SHERPA_PROFINET_IO_Reference_Device_for_R_IN32M3)」上で右クリック、「Update Device …」を選択

します。 
 

 
 
デバイスの更新ダイアログにて、「Fieldbusses – Profinet IO – Profinet IO Slave」以下にある

「SHERPA_PROFINET_IO_Reference_Device_for_R-IN32M3」を選択し「Update Device」ボタンをクリックし

ます。 
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4.3 ソフト PLC への接続手順 
開発環境からターゲットのソフト PLC にゲートウェイを介して接続する手順を記載します。 
 
 
4.3.1 ゲートウェイサーバの起動 
ゲートウェイサーバの動作状況をシステムトレイで確認し、停止している場合、   をクリックし「Start 
Gateway」を選択し起動操作を行なってください。ゲートウェイサーバは通常 Windows 起動時にサービスと 
して自動起動します。デスクトップ右下のシステムトレイにあるアイコンが動作状況を示しています。 
 

 
 
 
※システムトレイにアイコンがない場合  

スタートメニューよりすべてのプログラム＞3S CODESYS＞CODESYS Gateway V3＞  

CODESYS Gateway V3 を選択しゲートウェイサーバを起動してください。  

ゲートウェイサーバを起動しても、システムトレイにアイコンが表示されない場合はお使いの端末の再起動

をお試しください。 
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4.3.2 ソフト PLC 起動 
ソフトPLC の動作状況をシステムトレイで確認し、停止している場合、  をクリックし「Start  
PLC」を選択し起動操作を行なってください。ソフト PLC は通常 Windows 起動時にサービスとして自動起

動します。デスクトップ右下のシステムトレイにあるアイコンが動作状況を示しています。 
 

 
 
※システムトレイにアイコンがない場合  

スタートメニューよりすべてのプログラム＞3S CODESYS＞CODESYS Gateway V3＞  

CODESYS Gateway V3 を選択しゲートウェイサーバを起動してください。  

ゲートウェイサーバを起動しても、システムトレイにアイコンが表示されない場合はお使いの端末の再起動

をお試しください。 
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4.3.3 ソフト PLC との接続設定 
「デバイス」ウィンドウのツリーから「Device（CODESYS Control Win V3）」をダブルクリックし、「通 

信設定」画面を開きます。この画面で開発環境からソフト PLC サービスへ接続するための通信設定をする 

ことができます。「通信設定」タブの「Scan Network…」ボタンをクリックしてください。 

 

 

「デバイスの選択」ウィンドウが表示され自動的にローカルネットワークの利用可能なデバイスが検索され

ます。ソフト PLC サービスが見つかれば成功です。表示された PC 名をダブルクリックしてください。 

表示されない場合は前述した「4.3.1 ゲートウェイサーバの起動」と「4.3.2 ソフト PLC 起動」の設定を再度

ご確認ください。  

 

 

  

PC 名[数値]が表示されます。 
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4.4 デバイスのネットワーク設定 
 

4.4.1 Host IP アドレス設定 
デバイス設定を行う前にホストの IP アドレス設定を行います。「ネットワーク設定」を開きます。 

Windows7 では、Control panel->Network and Sharing Center->Change adapter settings 

 

 

ローカルエリア接続をダブルクリック（もしくは右クリック）しプロパティを選択。 
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TCP/IPv4 を選択し、プロパティボタンをクリック。 

 

 

下図赤枠にて IP アドレス、サブネットマスクを設定。 

 

 

以上で設定完了です。 
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4.4.2 Ethernet 設定 
デバイスウィンドウの「Ethernet (Ethernet)」をダブルクリックして設定ウィンドウを開きます。 

「General」タブにて、下図赤枠 Interface 横のアイコンをクリックしネットワークアダプター画面を表示さ 

せます。 

 

 

接続されたポート名が表示されますので使用するポートを選択してください。 

 

 

選択したポートの IP アドレスが正しく設定されているかご確認ください。 
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4.4.3 PN_Controller 設定 
デバイスウィンドウの「PN-Controller (PN-Controller)」をダブルクリックして設定ウィンドウを開きます。

設定ウィンドウ内、「General」タブにて設定を行います。 

前述した「4.4.2 Ethernet 設定」にて IP の設定を行っている場合、下図のように IP アドレス設定欄の横に

「adjust」の文字が表示されます。 

「adjust」をクリックすることで自動的に適した IP アドレスが設定されます。 

 

4.4.4 SHERPA_PROFINET_IO_Reference_Device_for_R_IN32M3 設定 
デバイスウィンドウ内の「SHERPA_PROFINET_IO_Reference_Device_for_R_IN32M3 
(SHERPA_PROFINET_IO_Reference_Device_for_R_IN32M3)」をダブルクリックして設定ウィンドウを開きま

す。設定ウィンドウ内、「General」タブにて設定を行います。 

IP 設定については前述した「4.4.3PN_Controller 設定」にて設定した「First IP address」~「Last IP address」
の範囲内の IP アドレスを設定してください。 

また、PROFINET ではスレーブデバイスの識別を「Station name」で行っています。ここはデバイス側で 

設定された「Station name」に応じて値を設定してください。 
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4.5 デバイスとの接続確認 
CODESYS 開発環境においてプログラムの実行方法及びデバイスの接続確認方法について記載します。 

 

「ビルド」メニューより「ビルド」を選択。 

 

 

「オンライン」メニューより「ログイン」を選択。 

 

 

「デバッグ」メニューより「運転」を選択でプロジェクトが Windows 上で実行されます。 
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デバイス名の横に接続の状況が表示されます。下図のように   となっていればデバイスとの接続が成功 

しています。 

 

 

デバイスステータス  

：PLC が接続されていてアプリケーションが実行中の状態です。  

：PLC が接続されていてアプリケーションが停止中の状態です。  

：エラーとなっています。エラー内容及びデバイス設定内容をご確認ください。  

：デバイス情報がデバイスリポジトリにありません。デバイス情報ファイルを見直した上で、 

インストールし直して下さい。 
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4.6 CODESYS 動作説明 
CODESYS 実行時、以下の画面が表示されます。評価ボードは以下の画面の Switch の状態を受信し、評価

ボードの LED を点灯させ、Switch の状態をそのまま送信します。 

 

 

下記に SW5 を ON した時のイメージを示します。 

 

 

 

 

Output : 0x10(=bit4 を 1) 

Input：0x10(=bit4 を 1) 

CODESYS 
SW5 を ON した場合、LED5 が点灯 

評価ボードの LED5 が点灯 

拡大 
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5. 参考ドキュメント 

 ドキュメント／アプリケーションノート／サンプルコード 
・R-IN32M3 シリーズ データシート 
・R-IN32M3 シリーズ ユーザーズマニュアル R-IN32M3-CL 
・R-IN32M3 シリーズ ユーザーズマニュアル R-IN32M3-EC 
・R-IN32M3 シリーズ ユーザーズマニュアル 周辺機能編 
・R-IN, RZ/T1, EC-1, TPS-1 グループ Software PLC Guide プロジェクト構築・UI 作成編 
・R-IN,RZ/T1 グループ Software PLC Guide PROFINET I/O 編 
 
最新版をルネサスエレクトロニクスホームページから入手してください。 
 
 

 
 テクニカルアップデート／テクニカルニュース 

（最新の情報をルネサスエレクトロニクスホームページから入手してください。） 
 
 開発環境 

（最新版を各ホームページから入手してください。） 
 
IAR 統合開発環境（IAR Embedded Workbench® for Arm）に関しては、IAR ホームページから入手して

ください。 
 
ソフトウェア PLC（CODESYS）に関しては、リンクス社ホームページから入手してください。 
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Appendix A  R-IN32M3-EC 評価ボードのコンフィグレーション変更方法 
ホスト PC と R-IN32M3-EC 評価ボードをシリアルで接続することにより、ホスト PC のターミナルソフト

より下記を変更することができます。 

 

名称 Default value 

Device Name dut 

IP Address 192.168.0.50 

Netmask 255.255.255.0 

Gateway 0.0.0.0 

MAC Address 74:90:50:f0:09:2e 

MAC Port1 74:90:50:f0:09:01 

MAC Port2 74:90:50:f0:09:02 

 

ボード出荷時に、本 PROFINET スタックプログラムを R-IN32M3-EC 評価ボードに書き込み、実行した場合

は、上記 Default value が FlashROM に書き込まれます。2 回目からは、FlashROM に書き込まれた初期値の

値が優先され起動します。 

 

A-1 システム構成 
以下にシステム構成を示します。 

図 A.1 システム構成図 

  

ホスト PC 

ターミナルソフト 

R-IN32M3-EC 評価ボード 

General USB 
mini-B cable 

USB Port R-IN32M3 

シリアル 
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A-2  コンフィグレーション変更方法 
 

A-2-1 R-IN32M3-EC 評価ボードの接続 
以下のように、各ケーブルを接続してください。 

(1) General USB mini-B Cable の mini-B を CN9:USB シリアルポートコネクタに接続し、ホストコンピュータ

と USB 接続。 

(2) DC5V 出力 AC アダプターを CN15 に接続し、電源を投入。 

 

 

A-2-2  コンフィグレーション変更方法 
 

(1) ターミナルソフト起動 

ターミナルソフトを起動して、シリアル通信設定を行います。以下にシリアル通信設定を示します。 

 

Baudrate 115200 bps 

Data 8 bit 

Parity None 

Stop 1 bit 

Flow control None 

 

以下にターミナルソフトの改行コードの設定を示します。 
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(2) R-IN32M3-EC 評価ボードリセット/スタート 

リセットボタンを押下すると、下記画面が表示されます。 

カウントダウンが「0」になる前に、キーボードから任意の値を入力します。  

 

FlashROM 領域を削除するため、「Do you erase the flash area? (y/n):」で「y」を入力して Enter を押下しま

す。再びカウントダウンが「0」になる前に、キーボードから任意の値を入力します。  

 

 

(3) Device Name 変更 

Device Name「dut」を変更する場合は、「y」を入力して Enter を押下します。変更しない場合は、「n」
を入力して Enter を押下します。 

 

 

(4) IP Address 変更 

IP Address「192.168.0.50」を変更する場合は、「y」を入力して Enter を押下します。変更しない場合は、

「n」を入力して Enter を押下します。 

 

 

  

0 になる前にキーを入力 

0 になる前にキーを入力 

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 
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(5) Netmask 変更 

Netmask「255.255.255.0」を変更する場合は、「y」を入力して Enter を押下します。変更しない場合は、

「n」を入力して Enter を押下します。 

 

 

(6) Gateway 変更 

Gateway「0.0.0.0」を変更する場合は、「y」を入力して Enter を押下します。変更しない場合は、「n」を

入力して Enter を押下します。 

 

 

(7) MAC Address 変更 

MAC Address「74:90:50:f0:09:2e」を変更する場合は、「y」を入力して Enter を押下します。変更しない場

合は、「n」を入力して Enter を押下します。 

 

 

  

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 
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(8) MAC Port1 変更 

MAC Port1「74:90:50:f0:09:01」を変更する場合は、「y」を入力して Enter を押下します。変更しない場合

は、「n」を入力して Enter を押下します。 

 

 

(9) MAC Port2 変更 

MAC Port2「74:90:50:f0:09:02」を変更する場合は、「y」を入力して Enter を押下します。変更しない場合

は、「n」を入力して Enter を押下します。 

 

 

(10) FlashROM への書き込み 

変更内容が問題なければ、「y」を入力して Enter を押下します。「Write data to flash!」表示で FlashROM
への書き込みが正常に完了です。再度変更したい場合は、「n」を入力して Enter を押下します。 

 

 

 

  

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 

ここを書き換えて、 
「Are you sure?」で「y」を入力

して Enter 押下 

変更した内容が表示されます 

FlashROM の書き込み正常終了 
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Appendix B  サンプルプログラムの注意事項 
 

 タイムアウト機能 
サンプルプログラムは、評価用のため、通信を 24 時間以上行うとタイムアウトする機能を有しておりま

す。タイムアウト機能を解除したい場合は、弊社パートナーの株式会社シェルパ(https://www.sherpa-
tech.net/)にお問い合わせください。 

 

 ベンダ ID 
本サンプルプログラムは、評価用のため、ルネサスエレクトロニクスが所有しているベンダ ID を利用し

ています。お客様のベンダ ID をご使用したい場合は、弊社パートナーの株式会社シェルパ

(https://www.sherpa-tech.net/)までお問い合わせください。 
 
 

https://www.sherpa-tech.net/
https://www.sherpa-tech.net/
https://www.sherpa-tech.net/
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ホームページとサポート窓口 
ルネサス エレクトロニクスホームページ 

http://japan.renesas.com/ 
 
お問合せ先 

http://japan.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
すべての商標および登録商標は，それぞれの所有者に帰属します。 

http://japan.renesas.com/
http://japan.renesas.com/contact/
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製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意

事項については、本ドキュメントおよびテクニカルアップデートを参照してください。 
 

1. 未使用端子の処理 
【注意】未使用端子は、本文の「未使用端子の処理」に従って処理してください。 
CMOS製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっています。未使用 
端子を開放状態で動作させると、誘導現象により、LSI周辺のノイズが印加され、LSI内部で貫通電 
流が流れたり、入力信号と認識されて誤動作を起こす恐れがあります。未使用端子は、本文「未使

用端子の処理」で説明する指示に従い処理してください。 
2. 電源投入時の処置 

【注意】電源投入時は，製品の状態は不定です。 
電源投入時には、LSIの内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定で 
す。 
外部リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端

子の状態は保証できません。 
同様に、内蔵パワーオンリセット機能を使用してリセットする製品の場合、電源投入からリセット

のかかる一定電圧に達するまでの期間、端子の状態は保証できません。 
3. リザーブアドレス（予約領域）のアクセス禁止 

【注意】リザーブアドレス（予約領域）のアクセスを禁止します。 
アドレス領域には、将来の機能拡張用に割り付けられているリザーブアドレス（予約領域）があり

ます。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスし

ないようにしてください。 
4. クロックについて 

【注意】リセット時は、クロックが安定した後、リセットを解除してください。 
プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した後に切り替えてくださ

い。 
リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムで

は、クロックが十分安定した後、リセットを解除してください。また、プログラムの途中で外部発

振子 
（または外部発振回路）を用いたクロックに切り替える場合は、切り替え先のクロックが十分安定

してから切り替えてください。 
5. 製品間の相違について 

【注意】型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してくださ 
い。 
同じグループのマイコンでも型名が違うと、内部ROM、レイアウトパターンの相違などにより、電 
気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ輻射量などが異なる場合がありま 
す。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 

 

 

  



 

 

 

 

 

○Arm および Cortex は、Arm Limited（またはその子会社）の EU またはその他の国における登録商標で

す。 All rights reserved.  

○Ethernet およびイーサネットは、 富士ゼロックス株式会社の登録商標です。 

○TRON は”The Real-time Operation system Nucleus”の略称です。 

○ITRON は”Industrial TRON”の略称です。 

○μITRON は”Micro Industrial TRON”の略称です。 

○TRON、ITRON、およびμITRON は、特定の商品ないし商品群を指す名称ではありません。 

○PROFINET は、PROFIBUS および PROFINET International (PI)の登録商標です。 

○CODESYS は、3S-Smart Software Solutions GmbH の登録商標または商標です。 

○その他、本資料中の製品名やサービス名は全てそれぞれの所有者に属する商標または登録商標です。 



 

 

 

■営業お問合せ窓口

■技術的なお問合せおよび資料のご請求は下記へどうぞ。
　総合お問合せ窓口：https://www.renesas.com/contact/

ルネサス エレクトロニクス株式会社　〒135-0061　東京都江東区豊洲3-2-24（豊洲フォレシア）

© 2018  Renesas Electronics Corporation. All rights reserved.
Colophon 6.0

http://www.renesas.com
※営業お問合せ窓口の住所は変更になることがあります。最新情報につきましては、弊社ホームページをご覧ください。

ご注意書き

1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システムの設計におい

て、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に起因して生じた損害（お客様

または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。

2. 当社製品、本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、著作権その他の

知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではありません。

3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。

4. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改変、複製、リ

バースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。

5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図しております。

標準水準： コンピュータ、OA機器、通信機器、計測機器、AV機器、

家電、工作機械、パーソナル機器、産業用ロボット等

高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、

金融端末基幹システム、各種安全制御装置等

当社製品は、データシート等により高信頼性、Harsh environment向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のある機器・システ

ム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機器と、海底中継器、原子力制

御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これらの用途に使用することは想定していませ

ん。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その責任を負いません。

6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導体デバイスの使

用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の範囲内でご使用ください。指

定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切その責任を負いません。

7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする場合がありま

す。また、当社製品は、データシート等において高信頼性、Harsh environment向け製品と定義しているものを除き、耐放射線設計を行っておりません。仮に当社

製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客様の責任において、冗長設計、延焼対策設

計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を行ってください。特に、マイコンソフトウェアは、単独

での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行ってください。

8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用を規制するRoHS

指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことにより生じた損害に関して、当社

は、一切その責任を負いません。

9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品および技術を輸

出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、それらの定めるところに従い

必要な手続きを行ってください。

10. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたします。

11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。

12. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。

注1. 本資料において使用されている「当社」とは、ルネサス エレクトロニクス株式会社およびルネサス エレクトロニクス株式会社が直接的、間接的に支配する会

社をいいます。

注2. 本資料において使用されている「当社製品」とは、注1において定義された当社の開発、製造製品をいいます。

(Rev.4.0-1  2017.11)
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